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SUMMARY:  31 

The goal of the protocol presented here is to generate and sample trajectories of configurations 32 

of liquid water molecules around catalytic species on a flat transition metal surface. The sampled 33 

configurations can be used as starting structures in quantum mechanics-based methods.   34 

 35 

ABSTRACT:  36 

A significant number of heterogeneously-catalyzed chemical processes occur under liquid 37 

conditions, but simulating catalyst function under such conditions is challenging when it is 38 

necessary to include the solvent molecules. The bond breaking and forming processes modeled 39 

in these systems necessitate the use of quantum chemical methods. Since molecules in the liquid 40 

phase are under constant thermal motion, simulations must also include configurational 41 

sampling. This means that multiple configurations of liquid molecules must be simulated for each 42 

catalytic species of interest. The goal of the protocol presented here is to generate and sample 43 

trajectories of configurations of liquid water molecules around catalytic species on flat transition 44 
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metal surfaces in a way that balances chemical accuracy with computational expense. 45 

Specifically, force field molecular dynamics (FFMD) simulations are used to generate 46 

configurations of liquid molecules that can subsequently be used in quantum mechanics-based 47 

methods such as density functional theory or ab initio molecular dynamics. To illustrate this, in 48 

this manuscript, the protocol is used for catalytic intermediates that could be involved in the 49 

pathway for the decomposition of glycerol (C3H8O3). The structures that are generated using 50 

FFMD are modeled in DFT in order to estimate the enthalpies of solvation of the catalytic species 51 

and to identify how H2O molecules participate in catalytic decompositions. 52 

 53 

INTRODUCTION:  54 

Modeling molecular phenomena involved in heterogeneous catalysis under liquid conditions is 55 

necessary for understanding catalytic function; however, this remains challenging because it 56 

requires a fine balance between chemical accuracy and computational expense. In general, since 57 

catalysis involves the breaking and forming of chemical bonds, quantum mechanics must be used 58 

to at least some degree; however, long simulations are challenging in quantum mechanics, as 59 

they require significant computer resources. Since molecules in the liquid phase are under 60 

constant thermal motion, simulations must also include configurational sampling, i.e., they must 61 

incorporate multiple spatial arrangements of the liquid molecules, as each different spatial 62 

arrangement (i.e., each configuration) has a different energy. This means that multiple 63 

configurations of liquid molecules must be simulated for each catalytic species of interest. These 64 

needs – to use quantum mechanics and to perform multiple calculations per catalytic species – 65 

can render modeling in heterogeneous catalysis under liquid phase computationally intractable. 66 

The purpose of the method described herein is to enable computationally tractable simulations 67 

of phenomena in heterogeneous catalysis under liquid phase.  68 

 69 

We are particularly interested in heterogeneously catalyzed reactions that are carried out under 70 

liquid water. Water molecules have significant influence on catalytic phenomena, such as 71 

interacting with catalytic species (e.g., via dispersion forces and hydrogen bonding)1-23, 72 

participating in catalytic reactions1,7-9,15,21,22,24-27, and influencing reaction pathways and/or 73 

catalytic rates1,11,12,15,18,23,25,27-31. Modeling of these phenomena has been performed using QM 74 

and/or ab initio molecular dynamics (AIMD)1,2,6,7,14,22,25,27,28,32-34, force field molecular dynamics 75 

(FFMD)35, and quantum mechanics/molecular mechanics (QM/MM)10. In AIMD and FFMD, the 76 

atoms in the system are moved pursuant to Newton’s equations of motion according to the 77 

forces acting upon them. In AIMD, the system energy and forces are calculated with quantum 78 

mechanics, whereas in FFMD, the system energy and forces are calculated using force fields, 79 

which are algebraic expressions that are parameterized based on experimental or QM data. In 80 

QM/MM, the portion of the system where the bond breaking and forming occurs is calculated 81 

with QM, and the remainder of the system is calculated with MM, which employs force fields. 82 

Because they directly employ QM, AIMD and QM/MM are better suited for capturing the bond 83 

breaking and forming that occurs in aqueous phase heterogeneous catalysis; however, FFMD is 84 

significantly more computationally tractable and thus better suited for generating the 85 

configurations of liquid H2O molecules. The method presented in this protocol balances chemical 86 

accuracy and computational expense by employing a combination of QM and FFMD.  87 

 88 



  

Specifically, this method uses FFMD simulations for generating configurations of liquid H2O and 89 

QM to calculate system energies. FFMD is carried out using LAMMPS.36 The force fields used in 90 

FFMD in this work employ Lennard-Jones + Coulomb (LJ+C) potentials, where the LJ parameters 91 

have been taken from the TIP3P/CHARMM model37 for H2O, the universal force field38 (UFF) for 92 

Pt, and the OPLS-AA force field39 for catalytic species, and the Coulomb parameters have been 93 

taken from the TIP3P/CHARMM37 model for H2O and the OPLS-AA force field39 for catalytic 94 

species. The Coulomb parameters for Pt atoms have been set to 0. QM calculations are 95 

performed using the VASP code40-42, which is a density functional theory (DFT) code. Water 96 

molecule insertions are performed with a code developed in-house called Monte Carlo Plug-in 97 

for Quantum Methods (MCPliQ). File conversions from VASP to LAMMPS in this protocol are 98 

performed with the Visual Molecular Dynamics (VMD) software43. 99 

 100 

The protocol is intended to generate configurations of liquid water molecules around catalytic 101 

species on flat transition metal surfaces at low coverage. Coverage is denoted 𝜃 and defined as 102 

the number of adsorbates per surface metal atom (i.e., the number of surface adsorbates 103 

normalized by the number of metal atoms in the topmost layer of the metal slab in the catalyst 104 

model). In this manuscript, low coverage is defined as θ ≤ 1/9 monolayer (ML), where 1 ML means 105 

one catalytic species per surface metal atom. The catalyst models should be placed in periodic 106 

simulation boxes. The simulation boxes do not have to be cubes. This manuscript demonstrates 107 

the use of the protocol for generating configurations of liquid H2O that can be used to calculate 108 

quantities of interest in aqueous phase heterogeneous catalysis. 109 

 110 

This protocol requires that the user has access to installed and working versions of the VASP, 111 

MCPliQ, LAMMPS, and VMD software. More information about VASP (https://www.vasp.at/), 112 

LAMMPS (https://Lammps.sandia.gov/), and VMD (https://www.ks.uiuc.edu/Research/vmd/) 113 

are available on their respective websites. The MCPliQ software is documented at 114 

https://github.com/getman-research-group/JoVE_article, along with all input files and Python 115 

scripts mentioned in this protocol. This protocol assumes that the executables and scripts 116 

mentioned within will be run on a high-performance research computer and are installed in a 117 

directory that is in the user’s $PATH variable. If an executable or script is placed in a location that 118 

is not in the user’s $PATH, then the path to the executable must be included to execute it. 119 

Executables and scripts are executed in steps 2.1.2, 2.2.1, 2.2.8, 3.1, 4.2, 5.2, and 6.1.2. For 120 

example, to execute the MCPliQ code in step 2.1.2 from a directory that is not in the user’s 121 

$PATH, the user would type $PATHTOMCPLIQ/mcpliq at the command-line interface instead of 122 

mcpliq, where $PATHTOMCPLIQ is the location where the mcpliq executable has been stored 123 

(e.g., $PATHTOMCPLIQ might be ~/bin). Before starting this protocol, all executables and scripts 124 

should be given executable permissions (e.g., in Linux, this could be done by typing chmod +x 125 

mcpliq at the command-line interface from the directory where the mcpliq executable is stored). 126 

Further, any modules required by any of the software or scripts should be loaded (these 127 

dependencies will be specific to individual installations of the various software and the computer 128 

where the simulations will be run). 129 

 130 

PROTOCOL:  131 

 132 



  

1. Generate the adsorbate structure 133 

 134 

1.1. Create a VASP POSCAR file comprising a supercell with periodic boundary conditions, as you 135 

would if you were performing simulations of adsorbates on metal surfaces under vacuum. The 136 

supercell should include an initial guess of the adsorbate structure and the metal surface as well 137 

as vacuum space above the adsorbate for adding H2O molecules. Details on how to do this are 138 

provided in previous work35,44. 139 

 140 

NOTE: It is important that the height of the vacuum space be at least 12 Å above the top of the 141 

adsorbate. 142 

 143 

1.2. Relax the structure and minimize its energy using the VASP code. Details on how to do this 144 

are provided in previous work35,44. This will produce a file called CONTCAR, which will be used in 145 

the next section. 146 

 147 

2. Add explicit H2O molecules 148 

 149 

2.1. Add N water molecules to the vacuum space in the CONTCAR created in step 1.2 using the 150 

MCPliQ code, where N = ρV, ρ is the density of water, and V is the volume of the vacuum space 151 

above the adsorbate. 152 

 153 

NOTE: ρ should be taken as the density of water as determined by the TIP3P/CHARMM water 154 

model at the simulation temperature. V will be refined in the next step. 155 

 156 

2.1.1. Specify the following information in the MCPliQ master_input.txt file: The number of H2O 157 

molecules to add (N) by changing the first argument in line 28, the path to the water.txt file by 158 

changing the second argument in line 28, and the minimum and maximum height of the supercell 159 

that can be occupied by water molecules by changing the Minimum z-coordinate in line 11 and 160 

the Maximum z-coordinate in line 12. 161 

 162 

2.1.2. Execute the MCPliQ code by typing mcpliq from the command-line interface to insert 163 

water molecules into the CONTCAR file. The code will output one or more files with the file 164 

extension of .POSCAR.  165 

 166 

NOTE: If more than one POSCAR files are produced, they will be named POSCAR_n.POSCAR. 167 

Select the file where n is largest. 168 

 169 

2.2. Generate the LAMMPS input files for an NPT simulation and equilibrate the cell volume using 170 

FFMD in the NPT ensemble in LAMMPS.  171 

 172 

2.2.1. Execute the script lmps_bond_angle.py on the .POSCAR file generated in step 2.1.2 by 173 

typing lmps_bond_angle.py $filename.POSCAR at the command-line interface, where $filename 174 

is the name of the .POSCAR file generated in step 2.1.2. This script creates a file called 175 

$filename.POSCAR.bond_angle_info.txt which lists bonds and angles that will be used in the 176 



  

LAMMPS data file. 177 

 178 

2.2.2. Open VMD and select File > New Molecule in the main window to open the Molecule File 179 

Browser window. Select VASP_POSCAR from the Determine File Type dropdown menu. Click 180 

Browse and navigate to the $filename.POSCAR file. Click Load to open the $filename.POSCAR 181 

file.  182 

 183 

2.2.3. Open the Tk Console within VMD by selecting Extensions > Tk Console from the VMD Main 184 

window. 185 

 186 

2.2.4. Execute the following command in the Tk console: topo writelammpsdata 187 

$WDPATH/data.myadsorbate full, where $WDPATH is the directory on the computer where 188 

VMD will write the LAMMPS data file and data.myadsorbate is the name of the LAMMPS data 189 

file. 190 

 191 

2.2.5. Delete the Bonds section at the bottom of the data.myadsorbate file. Then, append the 192 

bond and angle lists in the file $filename.POSCAR.bond_angle_info.text into data.myadsorbate. 193 

 194 

NOTE: The indexes for the O-H bond type and H-O-H angle type for the water molecules in the 195 

$filename.POSCAR.bond_angle_info.txt file are both set to 1. Thus, bond and angle types for 196 

adsorbates should start counting at 2.  197 

 198 

2.2.6. Edit the data.myadsorbate file by adding the Lennard-Jones parameters to the Pair Coeffs 199 

section and the Coulomb parameters to the Atoms section. Lennard-Jones and Coulomb 200 

parameters for the H2O molecules, adsorbate atoms, and metal surface atoms need to be added. 201 

 202 

NOTE: The Lennard-Jones parameters for Pt atoms, water molecules, and adsorbate atoms in this 203 

protocol are obtained from the UFF38, TIP3P/CHARMM37, and OPLS-AA39 force fields, 204 

respectively. Coulomb parameters for water molecules and adsorbates atoms are obtained from 205 

the TIP3P/CHARMM37 and OPLS-AA39 force fields, respectively. Coulomb parameters for Pt atoms 206 

are set to 0 in this protocol. Alternatively, calculated partial charges could be used for the 207 

Coulomb parameters for adsorbate atoms and Pt atoms. 208 

 209 

2.2.7. Copy the LAMMPS input file input.equil into the directory $WDPATH. Edit the group 210 

variable on line 34 to indicate the atom type indexes for the water oxygen and water hydrogen 211 

atoms and the group variable on line 35 to indicate the atom type indexes for the Pt and 212 

adsorbate atoms. 213 

 214 

2.2.8. Execute the LAMMPS software by typing mpiexec -n XX lmp_mpi < input.equil at the 215 

command-line interface, where XX is the number of CPU cores to use, and lmp_mpi is the name 216 

of the LAMMPS executable. Doing this will run an energy minimization to refine the H2O 217 

configuration, followed by a FFMD simulation performed at constant number of H2O molecules 218 

(N), volume (V), and temperature (T) to bring the water to the simulation temperature, followed 219 

by a FFMD simulation run at constant N, pressure (P), and temperature (T) to determine the 220 



  

physically correct height of the simulation box. Output files that will be used in section 3 are 221 

called data.myadsorbate_npt and log.myadsorbate.  222 

 223 

NOTE: The duration of the NPT simulation should be long enough to comprise an “equilibration” 224 

run, where the volume of the supercell comes to steady state, and a “production” run, which is 225 

used to sample the ensemble averages (here, the height of the supercell). During the 226 

equilibration run, the volume of the supercell when plotted against time should level off to a 227 

steady state value. Once this occurs, the NPT simulation can be said to be in its production run. 228 

Verify equilibration of the NPT simulation by ensuring that the fluctuations in the height of the 229 

supercell (lz) are minimal or have converged to a steady value. If large fluctuations occur, then 230 

re-generate a H2O configuration by decreasing the timestep on line 92 in the input.equil file and 231 

repeating step 2.2.8 or starting again from step 2.1.1 . 232 

 233 

3. Extract the proper height of the supercell 234 

 235 

3.1. Execute the script get_npt_lz.py on the log.myadsorbate file by typing get_npt_lz.py 236 

log.myadsorbate at the command-line interface. This script outputs the average supercell height 237 

from the “production” run portion of the NPT simulation in the avg_lz.txt file.  238 

 239 

NOTE: The get_npt_lz.py script assumes that LAMMPS writes the length of the cell z-dimension 240 

(lz) to the log.myadsorbate file every 1000 fs (customizable at line 20 of the get_npt_lz.py script), 241 

which is the default in the provided input.equil LAMMPS input file. The get_npt_lz.py script 242 

detects and discards the first 2 ns (customizable at line 19 of the get_npt_lz.py script) worth of lz 243 

values in the log.myadsorbate file, as they comprise the equilibration portion of the simulation, 244 

while the remaining 3 ns comprise the “production” portion and are thus used by the 245 

get_npt_lz.py script to compute the average z-dimension length. In addition to the avg_lz.txt file, 246 

the get_npt_lz.py script outputs a file called npt_data.txt, which provides values of lz as a function 247 

of the timestep, as well as a file called npt_plot.png, which plots the same data. The plot can be 248 

used to verify equilibration of the NPT simulation. 249 

 250 

3.2. Reconstruct the supercell using the average height determined in NPT.  251 

 252 

3.2.1. Copy the data.myadsorbate_npt file into a new directory, referred to here as $WD2PATH, 253 

and rename it data.myadsorbate.  254 

 255 

3.2.2. Edit the new data.myadsorbate file so that the lz height is equal to the average value 256 

output from the get_npt_lz.py script by changing the zlo and zhi arguments in the 257 

data.myadsorbate file such that zlo is 0.0 and zhi is the lz value from the avg_lz.txt file produced 258 

in step 3.1. 259 

 260 

4. Generate configurations of H2O molecules  261 

 262 

4.1. Copy the LAMMPS input file input.prod into $WD2PATH. Edit the group variable on line 32 263 

to indicate the atom type indexes for the water oxygen and water hydrogen atoms and the group 264 



  

variable on line 33 to indicate the atom type indexes for the Pt and adsorbate atoms. 265 

 266 

4.2. Execute the LAMMPS software by typing mpiexec -n XX lmp_mpi < input.prod into the 267 

command-line interface, where XX is the number of CPU cores to use, and lmp_mpi is the name 268 

of the LAMMPS executable. Doing this will run a constant NVT simulation on the H2O molecules. 269 

The key output file from this simulation is the dump.myadsorbate.lammpstrj file. 270 

 271 

NOTE: The duration of the NVT simulation should be long enough to comprise an equilibration 272 

run, where the energy of the system comes to steady state, and a production run, from which 273 

the ensemble averages (here, the spatial positions of the water molecules) are sampled. During 274 

the equilibration run, the energy of the system when plotted against time should level off to a 275 

steady state value. Once this occurs, the NVT simulation can be said to be in its production run. 276 

 277 

5. Determine the hydrogen bond lifetime for proper time sampling 278 

 279 

5.1. Edit the hb_lifetime_dist.py script to specify: the timestep of the first frame of the 280 

dump.myadsorbate.lammpstrj file by changing the actualStart variable on line 22, how often 281 

frames are written to the LAMMPS trajectory file by changing the timestep variable on line 23, 282 

the first and last timesteps the script should consider (i.e., the production portion of the 283 

trajectory) by changing the N_first and N_last variables on lines 24 and 25, whether consecutive 284 

frames are considered or frames are skipped by changing the nevery variable on line 26, and the 285 

number of lines per frame section of the trajectory file by changing the frameLine variable on line 286 

27. Additionally, edit lines 31 through 35 to specify which atom types within the 287 

data.myadsorbate file belong to the adsorbate and which atom types belong to the H2O 288 

molecules. 289 

 290 

NOTE: The hb_lifetime_dist.py script analyzes the H2O configurations in the production run and 291 

determines if any H2O molecules are hydrogen bonded to the adsorbate. It then counts the 292 

simulation time that each hydrogen bond remains intact and reports this information as a 293 

distribution of hydrogen bond lifetimes in units of ps. The specific version of the script that is 294 

provided with this protocol assumes that LAMMPS writes the configuration of H2O molecules to 295 

the dump.myadsorbate.lammpstrj file every 1000 fs, which is the default in the provided 296 

input.prod LAMMPS input file. It detects and discards the first 2 ns worth of configurations in the 297 

the dump.myadsorbate.lammpstrj file, as they comprise the equilibration portion of the 298 

simulation, and uses the remaining 3 ns to calculate hydrogen bond lifetimes.  299 

 300 

5.2. Execute the script hb_lifetime_dist.py on the dump.myadsorbate.lammpstrj file by typing 301 

hb_lifetime_dist.py at the command-line interface. Doing this will produce a file called 302 

distribution_HB_lifetime.dat. 303 

 304 

5.3. Plot the data in the distribution_HB_lifetime.dat file to view the distribution of hydrogen 305 

bond lifetimes that occurred during the NVT simulation. 306 

 307 

5.4. Determine the time increment to use for the time sampling interval based on the calculated 308 



  

hydrogen bond lifetimes. The best choice is the maximum hydrogen bond lifetime; alternatively, 309 

a value that would capture the 95% confidence interval can be used.  310 

 311 

6. Sample configurations of liquid H2O molecules  312 

 313 

6.1. Determine the number of configurations from the production run of the NVT FFMD 314 

trajectory for further calculations. The number of configurations should be selected so that the 315 

minimum time between configurations is equal to or greater than the time sampling interval 316 

identified in section 5.  317 

 318 

6.1.1. Edit the default value for the num_frames variable on line 21 of the lammps_frames.py 319 

script to specify the number of configurations to extract.  320 

 321 

6.1.2. Execute the script lammps_frames.py on the file dump.myadsorbate.lammpstrj by typing 322 

lammps_frames.py at the command-line interface. Doing this will output a list of simulation 323 

times corresponding to the configurations that should be extracted from the 324 

dump.myadsorbate.lammpstrj file. These configurations can be used as starting structures in 325 

AIMD or QM simulations.  326 

 327 

NOTE: 1) The lammps_frames.py script automatically detects the LAMMPS log and dump files as 328 

well as the production portion of the trajectory within the dump file and divides the number of 329 

configurations within the dump file into 10 groups. Alternatively, the user can specify the log file, 330 

the dump file, and the number of configurations from the command-line interface using the -l, -331 

d, and -n options, respectively. To do so, the user should type lammps_frames.py -n XX -l 332 

$logfilename -d $dumpfilename at the command-line interface, where XX is the desired number 333 

of configurations, $logfilename is the name of the LAMMPS logfile, and $dumpfilename is the 334 

name of the LAMMPS trajectory (dump) file. The simulation times that are output refer to the 335 

median times in each group. 2) If the configurations will be calculated in VASP with the LDIPOLE 336 

flag turned on, a small layer of vacuum space should be added to the top of the supercell above 337 

the water layer. This will facilitate convergence of the electronic structure in the VASP calculation. 338 

Adding an additional 3 Å of vacuum space above the H2O molecules has been successful in the 339 

simulations discussed below. 340 

 341 

REPRESENTATIVE RESULTS:  342 

One use of this protocol is to calculate the energies of interaction between the liquid water and 343 

catalytic species, i.e., ΔEint
35: 344 

 345 

∆𝐸int = 𝐸Catalytic species+H2O + 𝐸Clean catalyst surface − 𝐸Catalytic species −346 

𝐸Clean catalyst surface+H2O  347 

 348 

where ECatalytic species+H2O is the energy of a configuration of H2O molecules around a catalytic 349 

species on a metal surface, EClean catalyst surface is the energy of the clean catalyst surface in vacuum, 350 

ECatalytic species is the energy of the catalytic species on a metal surface in vacuum, and EClean catalyst 351 

surface+H2O is the energy of the configuration of H2O over the catalyst surface with the catalytic 352 



  

species removed. The positions of the H2O molecules used to calculate ECatalytic species+H2O and EClean 353 

catalyst surface+H2O should be identical. All values of E are calculated using the VASP code. The quantity 354 

ΔEint includes all of the physical and chemical interactions between all of the molecules in the 355 

liquid water structure and the catalytic species and gives a reasonable estimate of the enthalpy 356 

of solvation of the catalytic species, which is needed to calculate its free energy of solvation and 357 

total free energy. Table 1 provides values for ΔEint calculated for species on a Pt(111) catalyst 358 

surface with chemical formulas equal to CxHyOz in units of eV (1 eV = 96.485 kJ/mol). The values 359 

were calculated at coverages ≤1/9 ML.35,48 The values reported are the averages taken over 10 360 

configurations of liquid H2O, and the uncertainties are reported as standard deviations. All the 361 

values are negative, indicating favorable interactions with water.  362 

 363 

Another application of this protocol is to generate starting structures for AIMD. Movie 1 is a 364 

movie of an AIMD trajectory that was started from a configuration generated by this protocol. At 365 

the start of this movie, a COH adsorbate is shown on a Pt(111) surface under a structure of liquid 366 

H2O. One H2O molecule is emphasized, which formed a hydrogen bond with COH. Over the course 367 

of the movie, this H2O molecule abstracts the proton from the COH adsorbate and deposits a 368 

second hydrogen atom on the Pt(111) surface. The H2O molecule thus helps to catalyze the 369 

reaction COH* + *  CO* + H*, where the *s indicate catalytic sites. This simulation highlights 370 

the main strength and the main purpose of the multiscale sampling method described herein. 371 

Numerous configurations of H2O molecules are generated with FFMD, due to its strength in 372 

computational tractability. However, a limitation of FFMD is that it cannot capture bond breaking 373 

and forming unless a reactive force field is implemented. AIMD uses quantum mechanics to 374 

calculate energies and thus can capture bond breaking and forming. However, AIMD is too 375 

computationally demanding to generate all of the configurations of H2O molecules necessary to 376 

ensure sufficient sampling has been achieved. Thus, this protocol combines the two methods.  377 

 378 

The structures of liquid H2O molecules generated by this procedure are dependent on input 379 

settings. Setting these improperly can have unintended influences on the water structures. For 380 

example, when the intermolecular distances become too small or when other parameters in the 381 

molecular dynamics input files are set improperly or take on unphysical values, the water 382 

structure can become unreasonable. Under these circumstances, the structure of water will 383 

“blow up” unintendedly during the FFMD trajectory. Figure 1 shows an example of this. The 384 

snapshot on the left-hand side is the starting structure for a FFMD run, and the snapshot on the 385 

right-hand side is a snapshot taken within 1 ps of starting the simulation. As can be seen, the H2O 386 

molecules have moved far away from the surface. This is caused by improper settings made in 387 

the simulation input files and is not a structure that is likely to occur in reality. 388 

 389 

FIGURE AND TABLE LEGENDS:  390 

 391 

Figure 1: Example of a negative result. The force field molecular dynamics simulation “blows up” 392 

due to an unphysical setting or value. Left hand image: The starting geometry of the Pt(111) 393 

surface, adsorbate, and liquid water structure. Right hand image: The geometry of the Pt(111) 394 

surface, adsorbate, and liquid water structure less than 1 ps later. In the right-hand image, the 395 

H2O molecules have separated from the surface due to unphysically large forces. 396 



  

 397 

Movie 1: Ab initio molecular dynamics (AIMD) simulation initiated from a configuration 398 

generated in multiscale sampling. A H2O molecule that is originally hydrogen bonded to a COH 399 

adsorbate on a Pt(111) surface abstracts the proton from COH and deposits a second hydrogen 400 

on the Pt(111) surface. This bond breaking and forming event can be captured by AIMD but not 401 

with force field molecular dynamics (FFMD) unless a reactive force field is used. The initial 402 

configuration of H2O molecules used in this AIMD simulation was generated using FFMD as 403 

described in this manuscript. 404 

 405 

Table 1: Water-catalytic species interaction energy results. Interaction energies in eV calculated 406 

for eight CxHyOz adsorbates on Pt(111). Values reported are the averages taken over multiple 407 

configurations of liquid H2O. The uncertainties are the standard deviations of the averages. 1 eV 408 

= 96.485 kJ/mol. 409 

 410 

DISCUSSION:  411 

The method as presented was selected for its ease of implementation, but multiple 412 

customizations could be made. For one, the force fields used in the FFMD simulations can be 413 

modified. Changing the force field parameters and/or potentials can be done by editing the 414 

LAMMPS input and data files. Similarly, solvents other than H2O could be employed. To make this 415 

modification, the desired solvent molecule would need to be inserted starting from step 2.1.1, 416 

and the LAMMPS input files would need to be edited to incorporate the appropriate potentials 417 

and parameters. Inserting the new solvent molecule would also require supplying the internal 418 

coordinates of the solvent molecule in a .txt file analogous to the water.txt file. 419 

 420 

Another modification that could be made is to modify the area of the surface slab. The results 421 

discussed in this manuscript employed 3 Pt x 3 Pt or 4 Pt x 4 Pt surface slabs, which have surface 422 

areas less than 120 Å2. As the slab surface area increases, the computational expense also 423 

increases. Computational expense has the largest impact on section 5 of this protocol. If the data 424 

processing steps in section 5 become computationally prohibitive, big data post processing 425 

strategies such as those discussed in Li et al. 201845 can be employed. 426 

 427 

Possible sources of uncertainty for this procedure include the force field employed, the sampling 428 

method, and the sampling frequency. The water structure is determined by the force field that is 429 

used, meaning that the choice of force field could influence the specific configurations of H2O 430 

molecules. Our group has assessed how the choices of force field for H2O molecules and Pt atoms 431 

influence the interaction energies calculated in FFMD and found that the choice of force field 432 

contributes less than 0.1 eV to this interaction energy. Another source of uncertainty is the 433 

sampling method, which influences the specific configurations that are used to calculate a 434 

quantity of interest. Our group has compared the performance of the “time sampling” method 435 

presented in this protocol with an “energy sampling” method, which is biased to lower energy 436 

configurations of H2O molecules, on the interaction energies calculated in DFT and found both of 437 

these sampling methods give statistically equal values35,46. The sampling frequency can also 438 

influence the results. We have assessed how increasing the number of configurations from 10 to 439 

30,000 influences the average interaction energies calculated in FFMD for 40 different C3HxO3 440 



  

adsorbates and found that the sampling frequency contributes less than 0.1 eV to the average 441 

interaction energy44.  442 

 443 

The main limitation to this method is that the adsorbates are approximated by the structures 444 

under vacuum during the FFMD simulations. In reality, the adsorbates would exhibit 445 

conformational changes (bond stretches, angle bends, torsional motions, etc.) due to normal 446 

thermal movements, including interactions with solvent molecules. Attempts to include 447 

conformational changes of adsorbates into the FFMD simulations would require detailed 448 

development of force fields for catalytic surface adsorbates, i.e., which comprise terms that 449 

describe bond stretches, angle bends, and torsional terms, amongst others. As a future direction 450 

of this protocol, we are developing such force fields for adsorbates at solid surfaces, which we 451 

will use to determine the extent to which using rigid adsorbates influences the results. 452 
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Catalytic Species ∆E int (eV)

COH -0.70 ± 0.07

CO -0.03 ± 0.03

CH2OH -0.64 ± 0.12

CHO-CHOH-CH2OH -0.93 ± 0.22

COH-COH-CH2OH -0.87 ± 0.23

COH-CHOH-COH -1.72 ± 0.26

CHOH-COH-CO -1.57 ± 0.25

CHO-CO-CO -0.31 ± 0.19
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MCPliQ software
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Clemson University

JoVE article scripts
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Clemson University
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Comments/Description

Standard parallel VASP executable in the newest version.

Double-precision, parallel LAMMPS executable from 31 March 2017.

Standard VMD executable in the newest version.
Executable and input files for the MCPliQ software availabe from the Getman 

Research Group GitHub page.
Python scripts for this JoVE manuscript available from the Getman Research Group 

GitHub page.
PDB file for a water molecule, available from the Getman Research Group GitHub 

page or at http://www.rcsb.org/ligand/HOH.
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Dear Dr. Phillip Steindel: 
 
Thank you for sending the Editorial and Reviewer comments on our manuscript 
JoVE59284. Please find our responses to each comment below. In the responses 
below, Editor and Reviewer comments are written in upright (“normal”, roman) text, and 
our responses are italicized. 
 
Thank you again for handling our manuscript.  
 
Sincerely, 

 
Rachel Getman 
 
-- 
 
Editorial comments: 
 
General: 
 
1. Please take this opportunity to thoroughly proofread the manuscript to ensure that 
there are no spelling or grammar issues. 
 
All authors have proofread the manuscript. 
 
2. Please avoid the use of specific software names in the title. 
 
We have changed the title to “Multiscale Sampling of a Heterogeneous Water/Metal 
Interface using a Combination of Density Functional Theory and Force-Field Molecular 
Dynamics” 
 
Protocol: 
 
1. Please add more details to your protocol steps (see below). Please ensure you 
answer the “how” question, i.e., how is the step performed? Alternatively, add 
references to published material specifying how to perform the protocol action. If 
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revisions cause a step to have more than 2-3 actions and 4 sentences per step, please 
split into separate steps or substeps. 
 
Specific Protocol steps: 
 
1. 1.1-1.3: Please provide more details and/or a citation explaining how to do these 
steps. 
 
We added the following text to Steps 1.1 and 1.2: “Details on how to do this are 
provided in References 35 and 48.” As Step 1.3 was a simple re-naming step, we edited 
the master_input.txt file employed in Step 2.1 to read the original file. We thus deleted 
Step 1.3 from the protocol. 
 
2. 2.1.2: Where in this file, exactly, are these parameters modified? 
 
This is now Step 2.1.1. We rephrased Step 2.1.1 to read “Specify the following 
information in the MCPliQ master_input.txt file: The number of H2O molecules to add 
(N) by changing the first argument in line 28, the path to the water.txt file by changing 
the second argument in line 28, and the minimum and maximum height of the supercell 
that can be occupied by water molecules by changing the “Minimum z-coordinate” in 
line 11 and the “Maximum z-coordinate” in line 12.”  
 
3. 2.2.1, 3.1, 5.2, 6.3: How exactly are these scripts/programs executed on the 
command line; e.g., how are they modified for different files? Including the exact 
command used (as in 2.2.4) may help. 
 
We included more information in the protocol header: “This protocol requires that the 
user has access to installed and working versions of the VASP, MCPliQ, LAMMPS, and 
VMD software. More information about VASP (https://www.vasp.at/), LAMMPS 
(https://lammps.sandia.gov/), and VMD (https://www.ks.uiuc.edu/Research/vmd/) are 
available on their respective websites. The MCPliQ software is documented at 
https://github.com/getman-research-group/JoVE_article, along with all input files and 
Python scripts mentioned in this protocol. This protocol assumes that the executables 
and scripts mentioned within will be run on a high-performance research computer and 
are installed in a directory that is in the user’s $PATH variable. If an executable or script 
is placed in a location that is not in the user’s $PATH, then the path to the executable 
must be included to execute it. Executables and scripts are executed in Steps 2.1.2, 

mailto:rgetman@g.clemson.edu
http://www.clemson.edu/ces/computationalcatalysis
https://www.vasp.at/
https://lammps.sandia.gov/
https://www.ks.uiuc.edu/Research/vmd/
https://github.com/getman-research-group/JoVE_article


 

 
D E P A R T M E N T  O F  C H E M I C A L  A N D  B I O M O L E C U L A R  E N G I N E E R I N G  

College of Engineering and Science   127 Earle Hall   Box 340909   Clemson, SC 29634-0909 

864.656.3055   FAX 864.656.0784   www.clemson.edu/ces/chbe 

 

Rachel B. Getman, Ph.D. 
Associate Professor and College of Engineering, 
Computing and Applied Sciences Faculty Fellow 
Department of Chemical & Biomolecular Engineering 
Phone: (864) 656-5423 
Email: rgetman@g.clemson.edu 
Web: computationalcatalysis.sites.clemson.edu   

2.2.1, 2.2.8, 3.1, 4.2, 5.2, and 6.1.2. For example, to execute the MCPliQ code in Step 
2.1.2 from a directory that is not in the user’s $PATH, the user would type 
“$PATHTOMCPLIQ/mcpliq” at the command-line interface instead of “mcpliq”, where 
$PATHTOMCPLIQ is the location where the mcpliq executable has been stored (e.g., 
$PATHTOMCPLIQ might be ~/$USER/bin). Before starting this protocol, all executables 
and scripts should be given executable permissions (e.g., in Linux, this could be done 
by typing chmod +x mcpliq at the command-line interface from the directory where the 
mcpliq executable is stored). Further, any modules required by any of the software or 
scripts should be loaded (these dependencies will be specific to individual installations 
of the various software and the computer where the simulations will be run).” 
 
We additionally rephrased the following Steps:  
 
Step 2.1.2: “Execute the MCPliQ code by typing “mcpliq” from the command-line 
interface to insert water molecules into the CONTCAR file. The code will output one or 
more files with the file extension of .POSCAR.” 
 
Step 2.2.1: “Execute the script lmps_bond_angle.py on the .POSCAR file generated in 
Step 2.1.2 by typing “lmps_bond_angle.py $filename.POSCAR” at the command-line 
interface, where $filename is the name of the .POSCAR file generated in Step 2.1.2. 
This script creates a file called $filename.POSCAR.bond_angle_info.txt which lists 
bonds and angles that will be used in the LAMMPS data file.” 
 
Step 3.1: “Execute the script get_npt_lz.py on the log.myadsorbate file by typing 
“get_npt_lz.py log.myadsorbate” at the command-line interface. This script outputs the 
average supercell height from the “production” run portion of the NPT simulation to the 
screen.” 
 
Step 5.2: “Execute the script hb_lifetime_dist.py on the dump.myadsorbate.lammpstrj 
file by typing “hb_lifetime_dist.py” at the command-line interface. Doing this will produce 
a file called distribution_HB_lifetime.dat.” 
 
Step 6.3 is now Step 6.1.2 and reads: “Execute the script lammps_frames.py on the file 
dump.myadsorbate.lammpstrj by typing “lammps_frames.py” at the command-line 
interface. Doing this will output a list of simulation times corresponding to the 
configurations that should be extracted from the dump.myadsorbate.lammpstrj file. 
These configurations can be used as starting structures in AIMD or QM simulations.” 
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4. 2.2.2: How exactly is this file opened? 
 
We rephrased Step 2.2.2 to: “Open VMD, and select File → New Molecule in the Main 
window to open the Molecule File Browser window. Select VASP_POSCAR from the 
Determine File Type dropdown menu. Click Browse and navigate to the 
$filename.POSCAR file. Click Load to open the $filename.POSCAR file.” 
 
5. 2.2.8, 4.2: How exactly is LAMMPs software executed? 
 
We rephrased the following steps: 
 
Step 2.2.8: “Execute the LAMMPS software by typing “mpiexec -n XX lmp_mpi < 
input.equil” into the command-line interface, where XX is the number of CPU cores to 
use, and lmp_mpi is the name of the LAMMPS executable. Doing this will run an energy 
minimization to refine the H2O configuration, followed by a FFMD simulation performed 
at constant number of H2O molecules (N), volume (V), and temperature (T) to bring the 
water to the simulation temperature, followed by a FFMD simulation run at constant N, 
pressure (P), and temperature (T) to determine the physically correct height of the 
simulation box. Output files that will be used in Step 3 are called data.myadsorbate_npt 
and log.myadsorbate.” 
 
Step 4.2: “Execute the LAMMPS software by typing “mpiexec -n XX lmp_mpi < 
input.prod” into the command-line interface, where XX is the number of CPU cores to 
use, and lmp_mpi is the name of the LAMMPS executable. Doing this will run a 
constant NVT simulation on the H2O molecules. The key output file from this simulation 
is the dump.myadsorbate.lammpstrj file.” 
 
Highlighting: 
 
1. There is a 10 page limit for the Protocol, but there is a 2.75 page limit for filmable 
content. If revisions cause the highlighted portion to be more than 2.75 pages, please 
highlight 2.75 pages or less of the Protocol (including headers and spacing) that 
identifies the essential steps of the protocol for the video, i.e., the steps that should be 
visualized to tell the most cohesive story of the Protocol. 
 
We have modified the highlighting so that it is 2.75 pages.  
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2. 6.1, 6.2: These appear to be mostly vague calculation steps and cannot be filmed. 
 
These steps are now 6.1.1. and 6.1.2. We have eliminated the vague calculation 
instructions from these steps. The steps now read: 
 
Step 6.1.1: “Edit the num_frames variable on line 26 of the lammps_frames.py script to 
specify the number of configurations to extract.” 
 
Step 6.1.2: “Execute the script lammps_frames.py on the file 
dump.myadsorbate.lammpstrj by typing “lammps_frames.py” at the command-line 
interface. Doing this will output a list of simulation times corresponding to the 
configurations that should be extracted from the dump.myadsorbate.lammpstrj file. 
These configurations can be used as starting structures in AIMD or QM simulations.”  
 
References: 
1. Please ensure references have a consistent format. 
 
We have edited the references so that they all follow the same format. 
 
Table of Materials: 
1. Please ensure the Table of Materials has information on all materials and equipment 
used, including software and computational equipment. 
 
We have filled out the Table of Materials, including software. It is included with this re-
submission.  
  
Other: 
1. Please include, if possible, any software you have developed in your revised 
submission (this can be included as a single .zip file). 
 
We are including with our re-submission a zip file that contains the MCPliQ software as 
well as all of the scripts and input files that are used in this protocol.  
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Reviewers' comments: 
 
Reviewer #1: 
 
Manuscript Summary: 
 
This manuscript provides approach and necessary software (and scripts) to set up 
condensed phase simulations for catalytic systems. The manuscript provides the 
approach in great detail and it will be helpful for the community especially new graduate 
and undergraduate students in the fields. The protocol and scripts are easy to use and 
are well documented. The manuscript is well written and can be accepted for 
publications. Authors may want to revise the manuscript as some parts were highlighted 
(remove highlighting) prior to acceptance. 
 
We thank the Reviewer for their favorable review. With apologies to the Reviewer, we 
did not remove the highlighting. This is because the editor has requested that we use 
highlighting to indicate the portion of the protocol that we would like to be filmed.   
 
Reviewer #2: 
 
Manuscript Summary: 
 
The overall purpose of the manuscript, sampling solvent degrees of freedom in quantum 
chemical simulation of heterogeneous catalysis, is of broad interest. The authors 
present a computational protocol, combining QM and MM methods in different steps, to 
address this challenge. 
 
We thank the Reviewer for their interest into our protocol. 
 
Major Concerns: 
 
1) The protocol is far from ideal. The manuscript explains how to perform a complex 
simulation on a computer in many small steps, while the purpose of computers is 
exactly the opposite: they should handle many tedious steps, so that human beings 
don't have to bother with them. Many of the small steps in the presented protocol can be 
carried out by an overarching driver script, such that the user of this protocol does not 
have to worry about getting all the little steps right. To quote Steve Jobs: "Computers 
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are bicycles for the mind". In this paper, the computer becomes a treadmill for the mind. 
Having control over all small steps is useful for research, but this does not imply that a 
large amount of tedious work is necessary. On the contrary, you want to free your mind 
of having to deal with all the tediousness, so there is some room to think about what 
really matters. Most of it can be replaced by a software implementation of the presented 
steps, which the authors should consider. With such a software implementation, I doubt 
there would be much left for publication or video presentation. 
 
The reviewer is correct that we could have written a piece of software to carry out many 
of the steps in this protocol. We instead chose to write a protocol, which, as the 
reviewer also points out, allows flexibility that is useful for research. As we have written 
a protocol, we have submitted it for publication in the Journal of Visualized Experiments, 
which, according to its website (https://www.jove.com/about/) allows “educators and 
students to see the intricate details of cutting-edge experiments.”  
 
2) It is very difficult to make quantitative predictions with quantum chemical calculations 
of heterogeneous catalysis, also with the presented protocol. Can the authors reveal 
how well the example calculations compare to experiment? In addition, can they make 
error estimates, other than just sampling uncertainties (vide infra), in case no 
experimental data would be available? 
 
This protocol describes how to obtain configurations of liquid molecules at the interface 
of a heterogeneous catalyst surface that can be used in quantum chemical calculations, 
so while skepticism of quantum chemical calculations is acknowledged, it pertains to an 
application of the protocol rather than to the protocol itself.  
 
To answer the Reviewer’s questions:  
 
Can the authors reveal how well the example calculations compare to experiment? 
 
We assume that the Reviewer is asking about the calculated interaction energies. To 
our knowledge, there is no experimental method available for measuring these values. It 
would be plausible to compare observations from kinetic experiments to those from 
microkinetic modeling. From a computational standpoint, this would require that the 
interaction energies of many catalytic species be calculated and that the results be input 
to a microkinetic model, an endeavor that could comprise a protocol in itself. 
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In addition, can they make error estimates, other than just sampling uncertainties (vide 
infra), in case no experimental data would be available? 
 
Going back to the response above about comparing with experiment, Heyden’s group 
has developed a method of Uncertainty Quantification that can be used to determine 
how uncertainty in quantum chemical values can propagate into results from 
microkinetic modeling (Walker, Ammal, Terejanu, Heyden, “Uncertainty Quantification 
Framework Applied to the Water-Gas Shift Reaction over Pt-Based Catalysts,” Journal 
of Physical Chemistry C, 2016, 120, 10328-10339, DOI: 10.1021/acs.jpcc.6b01348.)  
 
For the protocol written in this manuscript, we have added the following paragraph to 
the Discussion section: “Possible sources of uncertainty for this procedure include the 
force field employed, the sampling method, and the sampling frequency. The water 
structure is determined by the force field that is used, meaning that the choice of force 
field influences the specific configurations of H2O molecules. Our group has assessed 
how the choices of force field for H2O molecules and Pt atoms influence the interaction 
energies calculated in FFMD and found that the choice of force field contributes less 
than 0.1 eV to the interaction energy. Another source of uncertainty is the sampling 
method, which influences the specific configurations that are used to calculate a 
quantity of interest. Our group has compared the performance of the “time sampling” 
method presented in this protocol with an “energy sampling” method, which is biased to 
lower energy configurations of H2O molecules, on the interaction energies calculated in 
DFT and found both of these sampling methods give statistically equal values.35,50 The 
sampling frequency can also influence the results. We have assessed how increasing 
the number of configurations from 10 to 30,000 influences the average interaction 
energies calculated in FFMD for 40 different C3HxO3 adsorbates and found that the 
sampling frequency contributes less than 0.1 eV to the average interaction energy.48 
The specific installation of any of the executables can also contribute to uncertainty in 
the calculated configurations and values. The influence on the calculated interaction 
energies is expected to be small (i.e., on the order of meV). This source of uncertainty 
can be minimized by properly equilibrating the H2O configuration in FFMD.” 
 
3) The authors should elaborate more on potential sources of error. Currently missing is 
e.g. the limited accuracy of the force field, such that not the (most) relevant 
configurations are sampled in the molecular dynamics simulation. Could there be more 
sources of uncertainty? 
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We have included discussions of potential sources of error in the Discussion section 
(see our response to Reviewer #2’s Major Concern 2 above).  
 
4) The protocol is not described in sufficient detail to produce a calculation. The authors 
should improve the description of the input and options for each script and which output 
is produced. Even better would be to write the protocol in Python, instead of plain 
English. 
 
The Editor also commented on this. To address this concern, we added the exact 
commands for executing the scripts in Steps 2.1.1, 2.1.2, 2.2.1, 2.2.2, 2.2.8, 3.1, 4.2, 
5.2, 6.1.1, and 6.1.2 (see our responses to the Editor’s comments above). We have also 
made the following edits:  
 
Added the following text to Step 1.2: “This will produce a file called CONTCAR, which 
will be used in the next Step.” 
 
Edited Step 2.2.4: “Execute the following command in the Tk console to generate the 
LAMMPS data file: “topo writelammpsdata $WDPATH/data.myadsorbate full,” where 
$WDPATH is the directory on the computer where VMD will write the LAMMPS data file 
and data.myadsorbate is the name of the LAMMPS data file.” 
 
5) The protocol description omits technical details on how the scripts written by the 
authors work, which may confuse the reader or user of the protocol. For example. take 
the script get_npt_lz.py in step 3. How does it determine which part of the NpT 
simulation comprises the production run? Usually, when computing such averages, the 
first N iterations of the MD trajectory are omitted because these are not representative 
for the equilibrium state. Does the script figure out which part is in equilibrium? Also, just 
to make this script more helpful, it would be good to let it also estimate the error on the 
average, e.g. using the block-averaging algorithm. This could be helpful to judge the 
convergence of the MD simulation. 
 
We added notes to the following steps, which describe how the scripts that we supply 
with this protocol work:  
 
Step 3.1: “The get_npt_lz.py script assumes that LAMMPS writes the length of the cell 
z-dimension (lz) to the log.myadsorbate file every 1000 fs (customizable at Line 10 of 
the get_npt_lz.py script), which is the default in the provided input.equil LAMMPS input 
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file. The get_npt_lz.py script detects and discards the first 2 ns (customizable at Line 9 
of the get_npt_lz.py script) worth of lz values in of the the log.myadsorbate file, as they 
comprise the equilibration portion of the simulation, while the remaining 3 ns comprise 
the “production” portion and are thus used by the get_npt_lz.py script to compute the 
average z-dimension length. In addition to the avg_lz.txt file, this script outputs the 
npt_data.txt file, which includes the timestep and lz data from the NPT portion of the 
LAMMPS trajectory, and the npt_plot.png file, which is a timestep vs. lz plot from the 
same data. The plot can be used to verify equilibration of the LAMMPS simulation.” 
 
Step 5.1: “Note: The hb_lifetime_dist.py script analyzes the H2O configurations in the 
production run and determines if any H2O molecules are hydrogen bonded to the 
adsorbate. It then counts the simulation time that each hydrogen bond remains intact 
and reports this information as a distribution of hydrogen bond lifetimes in units of ps. 
The specific version of the script that is provided with this protocol assumes that 
LAMMPS writes the configuration of H2O molecules to 
the dump.myadsorbate.lammpstrj file every 1000 fs, which is the default in the provided 
input.prod LAMMPS input file. It detects and discards the first 2 ns worth of 
configurations in the the dump.myadsorbate.lammpstrj file, as they comprise the 
equilibration portion of the simulation, and uses the remaining 3 ns to calculate 
hydrogen bond lifetimes. ” 
 
Step 6.1.2: “Note: The lammps_frames.py script automatically detects the LAMMPS log 
file and dump file as well as the production portion of the trajectory within the dump file 
and divides the number of configurations within the dump file into 10 groups. 
Alternatively, the user can specify the log file, the dump file, and the number of 
configurations from the command-line interface using the -l, -d, and -n options, 
respectively. To do so, the user should type “lammps_frames.py -n XX -l $logfilename -
d $dumpfilename” at the command-line interface, where XX is the desired number of 
configurations, $logfilename is the name of the LAMMPS logfile, and $dumpfilename is 
the name of the LAMMPS trajectory (dump) file. The simulation times that are output 
refer to the median times in each group.” 
 
 
 
 
 

mailto:rgetman@g.clemson.edu
http://www.clemson.edu/ces/computationalcatalysis


 

 
D E P A R T M E N T  O F  C H E M I C A L  A N D  B I O M O L E C U L A R  E N G I N E E R I N G  

College of Engineering and Science   127 Earle Hall   Box 340909   Clemson, SC 29634-0909 

864.656.3055   FAX 864.656.0784   www.clemson.edu/ces/chbe 

 

Rachel B. Getman, Ph.D. 
Associate Professor and College of Engineering, 
Computing and Applied Sciences Faculty Fellow 
Department of Chemical & Biomolecular Engineering 
Phone: (864) 656-5423 
Email: rgetman@g.clemson.edu 
Web: computationalcatalysis.sites.clemson.edu   

Minor Concerns: 
 
- The first two sentences of "long abstract" and "introduction" are identical. Lack of 
creativity? 
 
We edited the text in the long abstract to read: “A large number of heterogeneously-
catalyzed chemical processes occur under liquid conditions, but learning about how 
catalysts function under such conditions is challenging when it is necessary to include 
the solvent molecules. The bond breaking and forming processes modeled in these 
systems necessitate the use of quantum chemical methods.” 
 
- line 64: "arragement". Use a spelling checker to fix mistakes in the manuscript. 
 
We corrected this typo.  
 
- line 77: "In AIMD and FFMD ..." -> "In MD", the remainder of the sentence is valid, 
independent of how the forces are computed. QM/MM could also be used. 
 
The sentence prior compares three methods: AIMD, FFMD, and QM. The sentence in 
question discusses two of those. We agree with the reviewer that since both methods 
include MD, we could generalize; however, we feel as if the text is clearer as written.  
 
- line 86: Order of words in "significantly more computationally tractable"? E.g. 
"Computationally significantly more efficient" 
 
We discussed the two ways of wording and feel that the original version is clearer.  
 
- line 91: "Force fields used in FFMD employ Lennard-Jones + Coulomb (LJ+C) 
potentials, ..." This is formulated as a general statement for all force fields, but it mainly 
applies to the force field used in this work. In general, force fields can also use other 
functional forms for the van der Waals interactions. 
 
We changed this sentence to read, “The force fields used in FFMD in this work 
employ…” 
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- line 110: "period simulation boxes" => "periodic simulation boxes" 
 
We corrected this typo. 
 
- line 132: "optimize its energy" => "minimize its energy" 
 

We made this change. 
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